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Hi!

Read on and enjoy.

You’re here to learn about movie-making too, aren’t
you? Well, you’ve come to the right place!

Oh, hi! I’m Tazzter. I’m just helping my friends
Gustoff and Anna here. They’re the stars of our
animated movie!

Load the shots and sounds
onto your computer, checking that
they are good enough for
your movie.
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POST-PRODUCTION:
Arrange all your best
shots into the right order
so you can tell the story this is called ‘editing’.
Join up the sound effects,
voices and special effects.
Put your final cut (the
finished animation) on
DVD or the Internet.

Record voices and sound
effects.
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1

Rehearse and animate your characters
on the set, shooting it move by move,
scene by scene.

PRODUCTION:

3
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Write out the details of your story (the ‘script’) and figure out how you will
show the audience what happens in the story (the ‘treatment’ as they say
in showbiz).

Design and make your characters, build sets that fit in with the story you
want to tell.

Think up a story, use your imagination, but make sure you can tell your
story through simple animation.

PRE-PRODUCTION:

1

3
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T’S
WHAIDE
INS

Here’s a list of all the things you need
to do, to make a movie!

NOSE & EARS

for the nose and ears. Pop them in position, give them
a shape... then use our modelling tool or a pencil to
make small holes.

4. Roll small pinches of face-coloured plasticine into balls
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3.

SAD

MODELLING THE FACE

ANGRY

Soften the plasticine in your
hands by pressing and squeezing
it. Take very small amounts and
roll into small balls. It will soften
quickly and can then be more
easily applied.

With the tip of the modelling tool or a pencil, draw a hairline.
Place small pinches of plasticine inside the line, then shape and style
as you like! Try spikes or a bob!

HAIR

Flatten a small ball of
plasticine and wrap it around the
wrist and hand - no flimsy fingers
to fall off! For the thumb, roll a
very small ball and blend it on at
the side.

2.

plasticine all over the Easy-Action
Animation Figure. Press out the
edges until you have the thickness
you want.

1. Pinch and press small pieces of
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COVERING THE BODY
WITH PLASTICINE

CURIOUS

EYES

M

HAPPY

E

6.

A

O
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Bring your eyes to life with eyelids that blink! Roll two pinches of
face-coloured plasticine into balls, flatten into a disk shape big
enough to cover the whites of the eyes.

Roll a smaller ball of dark plasticine as the centre of each eye you need to be able to move them around to show eye movement.

W

The mouth is actually
mouths! At least five
different shapes made from
small pinches of red or pink
plasticine, rolled into balls and
flattened into sound shapes
and facial expressions.

Roll out two eyeballs using white plasticine. Press flat against
the face.

5.

SURPRISE

MOUTH

Giving your character a pair of shoes will help to complete the
look of your character and give it more balance. Roll two balls
of plasticine in a colour of your choice, shape and detail as
shoes and attach at the base.

Roll two small pinches of dark plasticine into a balls and
stretch out slightly into arches. Place these above the eyes
lightly – you will want to be able to move them easily.

7.

ADDING BROWS
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I’m the director, Gustoff.
I say when we start!

Gustoff hadn’t heard a word,
But set about trapping the bird.
As he stepped up, it got a fright
And in a flash took off in flight.

Just about to drop the net,
His sister ran to save the pet:
‘Stop! What are you doing, lad?
You’re nuts! Have you gone mad?’

He’d train the birds to be his mate,
Gustoff thought the idea was great!
He fetched a net to make a trap
And found a bird out eating scraps.

One day, Gustoff had a crazy notion
And began to put his plan in motion.
Holly was completely lost for words:
He said ‘I’m going fishing for birds!’

FISHING FOR BIRDS

Action!

Thanks to Anna, he was freed
But only after he’d agreed,
‘I Gustoff will keep my word,
I’ll never again go fishing for birds!’

Gustoff let out a mighty yelp,
Looking far and wide for help.
Lurching around, this way and that,
Crashing down with a great big splat!

Startled, he tried to go after it,
But caught his feet up in his kit.
His contraption worked alright It tangled Gustoff up real tight!

Start with a short and simple story - one you can
tell with just one or two characters and simple
props. I’ve decided to tell a story about Gustoff,
and the day he tried to fish for a bird! To make it
more fun, I’ve written out my story as a poem.

OK, story time!

CU stands for close
up – not much
background left, but
good for detail.

LS is a long shot – a bit
closer to the scene.

Shot 1 - LS Gustoff enters from the left
Shot 2 - LS Birdie flying overhead
Shot 3 - LS Gustoff comes up with a cunning plan
Shot 4 - LS Gustoff exits left of screen and Birdie
enters right pecking the ground
Shot 5 - LS Gutoff enters from the left with his net
Shot 6 - LS Anna enters right of screen (‘Stop!’)
Shot 7 - CU Anna saying her lines
Shot 8 - MS Gustoff setting his trap
Shot 9 - CU of Birdie almost under the net / trap
Shot 10 - CU Anna telling Gustoff to stop (rumble
tumble noise to the left)
Shot 11 - MS Gustoff entangled in the net
Shot 12 - CU Anna asking for help
Shot 13 - LS, Gustoff, Anna & Birdie (pecking crumbs)
tangled net on the ground, they wave goodbye

Shot list - Fishing for birds

MS is a medium shot
– from the waist up.
Good for ‘exposition
scenes’, movement and
some dialogue (speech).
dialogue

XLS means ‘extreme
long shot’ – one that is
filmed from far away
and takes in all of the
set. Sometimes called an
‘establishing shot’.

TYPES OF SHOTS

7
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This ‘shot list’
helps me work out
and plan my movie,
step by step.

XCU is an extreme
close up – no
background but just
the subject itself.

Full Shot – one that
includes most of the
body.
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Shot 8

Shot 7

Do I look good?

Shot 2

Shot 1

I’m the star.

Shot 9

Shot 3

Sketched frame-by-frame, a storyboard shows how your movie will look.
You only need a pencil and paper, so it’s a fast yet thorough way of working out
how you’re going to set up and photograph each shot. It also helps you check
that your audience will follow your story.

The storyboard is an important part of planning your movie before you
start shooting. It will help you to work out how best to tell your story through
pictures, and how to get around any challenges that may lie ahead. Otherwise,
you might only spot a problem when you are in the middle of shooting, when it
may be too late and require you to go ‘back to the drawing board’.

Storyboards help you prepare each
movie scene and keep unexpected
surprises to a minimum.

Then we get shots of him as the idea of catching a bird comes to him, and
then smiling.

I get him to turn bit by bit, taking a shot after each movement, following
the path of the bird across the sky. I show the bird flying across the top edge
of the frame.

I’ve got Gustoff looking up at the bird – you can see that his pupils are at
the tops of his eyes and his eyebrows are arched. I take a picture of him right
there, and then I get him to move one step forward and lift his arm up to his
chin. Then I take the next picture.

For our first scene - we want to show Gustoff looking
up at the sky. He spots a bird and suddenly has an idea.

Positions, PLEASE,
everybody!

A
e
movi
your acters
char

tion
c
u
d
Pro nimate

Get your characters
onto the set and let’s
get shooting.
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Peck away, Birdie, that’s
good. Now look over
your wing to see who is
coming. Very good!
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Next we need to pull back from the shot of the birdie, and show Gustoff trying
to adjust the net. He stops and is just about to drop the net when he sees
Anna coming.

Now we need to get a close up of the bird pecking the crumbs right under the
net – to show Gustoff plan.

Gustoff! Putting this trap
together is getting you a
little annoyed.
...aaand ACTION!

Gustoff then goes off to get his net. He comes back into the frame with it,
sets up his trap and throws some crumbs on the ground to tempt the bird.

Keep looking up, Gustoff,
but turn your head slightly
towards the camera, and I’ll
take another shot.
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M (uts)

E (ain)

O (nu)

M (br)

A (have)

A (are)

E (t)

A (lad)

OO (o)

M (st)

O (gone)

O (or)

W (you)

W (you)

O (p)

M (b)

A (has)

O (go)

O (d)

W (wh)

A (ad)
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W (your)

E (ne)

W (oing)

W (a)

Here are the shots that we have taken of Anna as she says her lines to Gustoff.
If you are having any difficulty working out the expressions and mouth shapes
for your character, why not act out the lines yourself in front of a mirror?

!

You will need to take photos of Anna with these mouth shapes to make it look
like she is talking. Don’t forget to change her facial expressions, too. We will be
matching them to sound after we have finished taking all the photographs.

‘Stop! What are you doing, lad?
Have you gone nuts or has your
brain gone bad?’

OK, Anna, time for your scene. I hope
you remember your lines.
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Follow the on-screen options: your computer will ask you to save your photos.
Create a new folder specially for this animation – let’s call it ‘Fishing for Birds’.

Getting your photographs from your camera to your computer should be just a
matter of connecting up the camera and turning it on.

UPLOADING YOUR IMAGES

CONGRATULATIONS!
You’ve come to the end of the animating. Did you try something
similar? Great! Now let’s get the results onto the computer for
editing right away. I can’t wait to see how it all looks!

That’s great ... smile
and wave, guys! Smile
and wave! AND CUT.

Our story ends with Gustoff caught up in his own trap and Anna releasing him
only after he promises never to try this kind of thing again. Poor Gustoff he really doesn’t like having his sister come to the rescue!

OK! Remember Gustoff... act as
if you are really tied up in the
net. Very Good... aaand ACTION!

Once the images are imported, they will appear in the storage area
under Collections. Now is a good time to save this project, so go to the
File menu again and save ‘Fishing for Birds’ as a Movie Maker project.
Now, to see how those photographs you have taken work as a movie:
highlight all your stills and drag them down into the timeline. Once
they are all lined up in the timeline, click on the Play button and enjoy
the MAGIC OF ANIMATION! View it a few times before doing any
13
editing.

2

3
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Under the File menu or from the shortcut links, choose the Import
task, and browse through your computer to where you have saved
your images. Select all your images into one group and hit Import.

1

Spend a few minutes exploring the movie editor programme.
Make sure you set your imported image to .125
seconds in the View Menu / Options

3. The timeline, where we put
the movie together and add
special effects and sound.

2. The monitor, where we
view the results of the
editing.

1. The storage, where we
store and find all the files –
images and sounds – that we
can mix and edit together.

Most PCs will have a programme like
Movie Maker, for example, that allows you
to edit movies, while on Mac, it will probably be iMovie.
There are many others - they all work in much the same
way, but with different labels for the same things.

A movie editor programme has three main features

Edit orldwide
w
for a ience
aud

ction
u
d
o
r
P
e
Post- your movi

Our first shoot is over.
LET’S GET EDITING
AND SEE HOW IT LOOKS!
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Now match up your images to the voice you have just recorded by dragging the right
image for the right sound into the timeline at the point where you need it. As you
go along, you can press Play on the monitor to see how well the sounds fit with the
pictures (‘lip-syncing’). It’s easy then to move the images about to match the right
mouth shape and face expression to the word or sound. You can also easily pull in
extra images or a better image from your image collection folder. Just drag and drop
it on the timeline where you think it should go. Remember: if it’s the wrong image,
you can just delete it from the timeline and try a different one.

Just pull
it into the
timeline

Plug your microphone into the computer, switch
it on and start recording your voice. Click Start
Narration. When you have finished recording
what you want your character to say, click Stop
Narration. Movie Maker will prompt you to save
your sound file and place it onto the timeline.

To make a frame last longer or shorter, select the frame and drag the
‘handles’ outwards or inwards – changing the image width changes the time
it lasts in the movie.
You can change the order of frames and re-use certain frames (for example,
mouth shapes and facial expressions, etc.) by using the usual copy and paste/
drag and drop methods. To give Anna a voice, you need to click on the microphone
icon on the timeline.

5

6

If you need to delete a frame that you don’t want, just click on it in the
timeline and hit Delete.

4
Finally, to publish your animation, go to File / Save Movie. In Settings, select Other
… and scroll down to Video for broadband file content (150 kbps total) and click OK.

You can also experiment with a range of effects under the Tools menu and Video
Effects.

Fishing for Birds

GOOD NETIQUETTE
When posting movies on the internet,
keep your credits short. Open with your
movie title and place all other credits at
the end.
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Note to parents: Animatazz.com adheres to a strict child protection policy and
applies firm web ethics in its running. It is a safe environment for children to
exhibit their movies as well as enjoy those of others. The Animatazz team checks
every movie from start to finish before it is posted.
15

Animatazz.com also helps teachers, parents and guardians get the most from
the Animatazz experience as edutainment.

Animatazz.com has a blog where you can share animation tips with other
enthusiasts. The site is packed with technical hints and links to other animation
services that you may want to try, for example, applications for audio editing
and frame capturing.

Animatazz.com is a secure resource for people interested in the making of stopmotion animation movies, bringing together information and resources from
many areas of stop-motion animation movie-making.

If your movie meets our approval, Animatazz.com will host your movie in our
movie gallery and on the Animatazz channels of other sharing sites such as
YouTube.

USING THE ANIMATAZZ WEBSITE

Put your movie on your
phone. Email it to friends.
Put it up on YouTube. Send
it to Animatazz to be
included in our animation
movie gallery!

Send it to Animatazz to
be included in our animation
movie gallery

YOU HAVE A RANGE OF OPTIONS FOR WHAT TO DO WITH YOUR MOVIE:

8

7

Phew, I’m tired after
all that movie work,
but it was great fun,
wasn’t it?

And we still have to
go to the premiere!

They have a red carpet for
us, and Fishing for Birds up
in lights!

Club Animatazz Ltd
Guiness Enterprise Centre Taylor’s Lane Dublin 8
© Club Animatazz Ltd 2008. www.animatazz.com
© 2010 Drumond Park Limited www.drumondpark.com
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